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Type Conventions Used in This Document
Convention Meaning or Use

Bold Items in the user interface that you select or click. Text that you type 
into the user interface.

<Italic> Variables in commands, code syntax, and path names.

Ctrl+L Press the two keys at the same time.

Courier Code examples. Messages, reports, and prompts from the software.

... Omitted material in a line of code.

.

.

.

Omitted lines in code and report examples.

[ ] Optional items in syntax descriptions. In bus specifications, the 
brackets are required.

( ) Grouped items in syntax descriptions.

{ } Repeatable items in syntax descriptions.

| A choice between items in syntax descriptions.
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Chapter 1

Installing Diamond Tools

This document provides installation instructions for the Lattice Diamond® 
Linux software.

Diamond supports ASC, ECP5U, ECP5UM™, ECP5UM5G™, LatticeEC™, 
LatticeECP™, LatticeECP2™, LatticeECP2M™, LatticeECP2S™, 
LatticeECP2MS™, LatticeECP3™, LatticeSC™, LatticeSCM™, LatticeXP™, 
LatticeXP2™, LIFMD (CrossLink™), LIFMDF (CrossLinkPlus™), LFMNX 
(Mach-NX™), MachXO™, MachXO2™, MachXO3D™, MachXO3L™, 
MachXO3LF™, Platform Manager™, and Platform Manager 2 designs. 

System Requirements
The following are the basic system requirements for Lattice Diamond on 
Linux:

 Intel Pentium or Pentium-compatible PC, or AMD Opteron system 
support:

For Diamond Programmer:

 The Lattice Diamond 64-bit release contains a 64-bit driver to support 
the 64-bit system.

 Red Hat Enterprise Linux version 7.9 or 8.8 operating system.

The host operating system can only be 64-bit.

 Ubuntu version 20.04 or 22.04 LTS operating system.

 The Lattice Diamond software has 64-bit specific application programs 
to run on Red Hat 64 platforms.

Note
The available devices vary depending on the type of license.
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 The Lattice Diamond software is available in 64-bit versions. The 64-
bit version of Lattice Diamond can only be installed on 64-bit systems.

 Approximately 10 GB free disk space

 Network adapter and network connectivity 

 1024 x 768 graphics display

 JavaScript-capable Web browser

 Adobe Acrobat Reader, or equivalent PDF reader

Memory Requirements
Table 1 lists the minimum memory requirements and recommended memory 
for all the Lattice Semiconductor FPGA families.

Note
A floating license requires access to the license server, so both a network adapter 
and connectivity are required.

Table 1:  Recommended Memory for Linux
Device Size 64-Bit Operating Systems

Minimum Recommended

ECP5U/UM/UM5G All 4 GB 6 GB

LatticeEC, LatticeECP Up to 20K LUT 1 GB 1.5 GB

Up to 50K LUT 1.5 GB 2 GB

LatticeECP2/M Up to 20K LUT 1.5 GB 2 GB

Up to 50K LUT 2 GB 3 GB

Up to 100K LUT 2 GB 4 GB

LatticeECP3 Up to 95K LUT 4 GB 6 GB

Up to 150K LUT 6 GB 8 GB

LatticeSC/M Up to 40K LUT 1.5 GB 2 GB

Up to 115K LUT 2 GB 5 GB

LatticeXP, LatticeXP2 Up to 20K LUT 1 GB 1.5 GB

Up to 50K LUT 1.5 GB 2 GB

LIFMD (CrossLink),

LIFMDF (CrossLinkPlus)

All 512 MB 1 GB
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Technical Support
FAQs

The Answer Database provides solutions to questions that many of our 
customers have already asked. Lattice Applications Engineers are 
continuously adding to the database. 

To access the Answer Database, go to www.latticesemi.com > Support > 
Answer Database.

For Technical Support Assistance

Submit a technical support case via technical support case portal or go to 
www.latticesemi.com > Support > Technical Support Request.

For Local Support

Contact your nearest Lattice Sales Office.

Installer Contents
The Lattice Diamond software installation packages are available for 
download from http://www.latticesemi.com/latticediamond. Click the 
Downloads tab. Some documents and downloads are not visible to 
anonymous visitors. To view all items, please log in to your Lattice account. 
Follow the product download instructions and uncompress the software.

The following describes the contents of the Lattice Diamond installer.

 The Lattice Diamond, Reveal, Programmer, and Power Estimator Linux 
installer run files have the following convention for 64-bit platforms.

 [version]_[product]_lin.run - 64-bit platform

 The Lattice Diamond, Reveal, Programmer, and Power Estimator run file 
names are as follows:

 3.14.0.75.2_Diamond_lin.run

 3.14.0.75.2_Diamond_PowerEstimator_lin.run

MachXO, MachXO2, 
MachXO3D, MachXO3L, 
MachXO3LF,Mach-NX

All 512 MB 1 GB

Platform Manager,
Platform Manager 2

All 512 MB 1 GB

Table 1:  Recommended Memory for Linux (Continued)
Device Size 64-Bit Operating Systems

Minimum Recommended

http://www.latticesemi.com/techsupport
http://www.latticesemi.com/en/Support/AnswerDatabase.aspx
http://www.latticesemi.com/Buy.aspx
http://www.latticesemi.com/en/Support/AnswerDatabase.aspx
http://www.latticesemi.com/en/Support/AnswerDatabase.aspx
http://www.latticesemi.com/latticediamond
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 3.14.0.75.2_Diamond_Programmer_lin.run

 3.14.0.75.2_Diamond_Reveal_lin.run

 The Lattice Diamond “base” installation file (.run) installs Lattice Diamond 
and Synplify Pro for Lattice. See “Diamond 3.14 Release System Library 
Dependencies” on page 11 for more information.

 The Reveal installation file (.run) installs the stand-alone Reveal Analyzer. 
It is not necessary to install this package if the Diamond Base RUN is 
installed. See “Installing Stand-Alone Reveal Analyzer” on page 12 for 
more information.

 The Programmer installation file (.run) installs the stand-alone Diamond 
Programmer. It is not necessary to install this package if the Diamond 
Base RUN is installed. See “Installing Stand-Alone Programmer” on 
page 13 for more information.

 The Power Estimator (.run) file installs the stand-alone Diamond Power 
Estimator. It is not necessary to install this package if the Diamond Base 
RUN is installed. See “Installing Stand-Alone Power Estimator” on 
page 14 for more information.

 The LatticeMico installation file (.run) installs LatticeMico Development 
Tools and GNU-based Compiler Tools. See “Installing LatticeMico 
Development Tools” on page 31 for more information.

 The Installation Notice contains installation and licensing information.

Diamond Installed Directory Structure
Table 2 shows the Lattice Diamond software directory structure after 
installation:

Table 2: The Diamond Software Directory Structure
File or Directory Description

bin/lin64/ This directory contains files for running the Lattice Diamond 64-
bit GUI.

cae_library/ This directory contains synthesis header libraries for Synplify 
Pro in both Verilog and VHDL formats. It also contains the 
libraries for interface kits (ispLSI® design and simulation 
libraries).

data/ This directory contains files for the Lattice Diamond software.

docs/ This directory contains Lattice Diamond documentation, 
including manuals, tutorials, and the online Help.

embedded_source/ This directory contains source code files for the JTAG Full VME, 
JTAG Slim VME, Slave SPI, I2C, and sysCONFIG embedded 
systems for Lattice FPGA devices.

examples/ This directory contains Lattice design examples.

ispfpga/ This directory contains files for the Lattice Diamond software.
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Installing Lattice Diamond on 64-Bit Platforms
Before installing the Lattice Diamond software, download the installation files 
from the Lattice Semiconductor Web site. For more information on how to 
download the Diamond software, go to
http://www.latticesemi.com/latticediamond. Click the Downloads tab. Some 
documents and downloads are not visible to anonymous visitors. To view all 
items, please log in to your Lattice account. Follow the product download 
instructions and uncompress the software.

The RUN file has a companion MD5 checksum file. The MD5 file permits you 
to validate the integrity of the RUN file. 

Lattice Diamond for 64-bit systems is installed with the 
3.14.0.71.0_Diamond_lin.run installation file. The file installs all Lattice 
Semiconductor FPGA devices on your 64-bit system. It also installs the 
Synplify Pro for Lattice software. The following section guides you through the 
installation procedure step by step.

To install the Diamond software on 64-bit systems:

1. Go to Diamond software installers directory and execute the Diamond run 
file. Make sure the companion MD5 file is located in the same directory as 
the RUN file.

% cd <directory_with_RUN>
% ./3.14.0.75.2_Diamond_lin.run

license/ This directory contains the license agreement.

module/ This directory contains Lattice module files.

questasim/ This directory contains files for the QuestaSim for the Lattice 
Diamond software.

synpbase/ This directory contains files for the Synplify Pro for Lattice 
software.

tcltk/ This directory contains tcl/tk related files.

Table 2: The Diamond Software Directory Structure (Continued)
File or Directory Description

Note
Platform Manager 2 devices require the Diamond Platform Designer tool. The 
LatticeMico Development Tools must be installed along with Diamond in order to use 
Platform Designer, Refer to “Installing LatticeMico Development Tools” on page 31.

Note
 In the Diamond installation, blank space characters are not allowed in the 

installation directory path name.

http://www.latticesemi.com/latticediamond
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2. Install the Diamond software. The default installation directory for 
Diamond is $HOME/lscc/diamond. You have the option of changing the 
installation directory.

 To install to the default location ($HOME/lscc/diamond/3.14):

% cd <directory_with_RUN>
% ./3.14.0.75.2_Diamond_lin.run

Diamond 3.14 Release System Library Dependencies
The Diamond RUN package depends on a set of packages that provide 64-bit 
system libraries. Some of these packages may depend on lower level 
packages, the indirect dependencies. To fulfill this dependency, these 
packages must be installed before Diamond 3.14 can be installed. Check 
which ones are already present on your system by entering the command 
rpm -qa | grep <package name> and confirming that the named 
package appears in the results.

You can type the following command to determine the required libraries. 

% ./bin/lin64/check_systemlibrary_diamond.csh

The following packages are the packages diamond_3_13-base-56-2-x86_64-
linux.run depends on. This list does not include packages that are included 
with Diamond 3.14. Indirect dependencies are listed with indented levels.

 glibc

 nss-softokn-freebl

 libjpeg

 libtiff

 zlib

 glib2

 libselinux

 gamin

 libusb

 freetype

 fontconfig

 expat

 libX11

 libxcb

 libXau

 libICE

 libSM

 libuuid



INSTALLING DIAMOND TOOLS : Installing Diamond Tools

Lattice Diamond 3.14 Installation Guide for Linux 12

 libXt

 libXext

 libXrender

 libXi

 libXft

 gstreamer1

 cdparanoia-libs

 opus

 libtheora

 iso-codes

 libvisual

 libglvnd-glx

 libglvnd

 gstreamer1-plugins-base

Installing the packages one by one requires the parent package to be installed 
last. The package deepest in the tree must be installed first. For example, 
libICE package depends on libSM. The libSM package must be installed prior 
to libICE.

Two cyclic dependencies are found with Diamond, glibc and nss-softokn-
freebl, and glib2 and gamin. Installing these packages requires the two RPM's 
to be specified on the same rpm command line.

Installing Diamond Tools 
This section describes how to install Diamond software tools including Stand-
Alone Reveal Analyzer and Stand-Alone Programmer..

Installing Stand-Alone Reveal Analyzer
Reveal Analyzer is included in the Diamond installation. If you want to use the 
tool without installing Lattice Diamond, use one of the following files to install 
the stand-alone Reveal Analyzer:

 3.14.0.75.2_Diamond_Reveal_lin.run for 64-bit systems.

Note
User needs to make sure libusb-0.1.so.4 and libXss.so.1 are installed in Red Hat 7.4, 
and they are default installed in Red Hat 6.9 or earlier.
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To install the stand-alone Reveal Analyzer:

1. Close all applications before starting installation

2. Go to Radiant software installers directory and execute the Radiant 
Reveal run file.

% cd <directory_with_RUN>
% ./3.14.0.75.2_Diamond_Reveal_lin.run

3. The Welcome To Lattice Radiant Reveal setup dialog box opens.

4. Click Next to open the Installation Folder dialog box.

5. The default destination folder is /home/lattice/lscc/reveal/diamond/3.14. 
Click Browse to change the destination folder.

6. Click Next to open the Select Components dialog box.

7. Click Next to open the License Agreement dialog box.

8. Read the license agreement. If you agree, click I accept the license to 
continue the installation process.

9. Click Next to Ready to Install dialog box. Review the destination folder 
and components selected. If everything is correct, select Install to start 
the installation.

10. In the Installation Wizard Complete dialog box, read the note and click 
Finish.

Installing Stand-Alone Programmer
Programmer is included in the Diamond installation and consists of five tools:

 Programmer

 Deployment Tool

 Download Debugger

 Programming File Utility

 Model 300 Programmer

If you want to use Programmer, Deployment Tool, Download Debugger, 
Programming File Utility, or Model 300 Programmer without installing Lattice 
Diamond, use one of the following files to install the stand-alone Programmer:

 3.14.0.75.2_Diamond_Programmer_lin.run for 64-bit systems.

To install the stand-alone Radiant Programmer:

1. Close all applications before starting installation

2. Go to Radiant software installers directory and execute the Radiant 
Programmer run file.

% cd <directory_with_RUN>
% ./3.14.0.75.2_Diamond_Programmer_lin.run

3. The Welcome To Lattice Radiant Programmer setup dialog box opens.
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4. Click Next to open the Installation Folder dialog box.

5. The default destination folder is /home/lattice/lscc/programmer/radiant/
2024.1. Click Browse to change the destination folder.

6. Click Next to open the Select Components dialog box.

7. Click Next to open the License Agreement dialog box.

8. Read the license agreement. If you agree, click I accept the license to 
continue the installation process.

9. Click Next to Ready to Install dialog box. Review the destination folder 
and components selected. If everything is correct, select Install to start 
the installation.

10. In the Installation Wizard Complete dialog box, read the note and click 
Finish.

Installing Stand-Alone Power Estimator
Power Estimator is included in the Diamond installation. If you want to use the 
tool without installing Lattice Diamond, use one of the following files to install 
the stand-alone Power Estimator:

 3.14.0.75.2_Diamond_PowerEstimator_lin.run for 64-bit systems.

To install the stand-alone Power Estimator:

1. Close all applications before starting installation

2. Go to Radiant software installers directory and execute the Radiant Power 
Estimator run file.

% cd <directory_with_RUN>
% ./3.14.0.75.2_Diamond_PowerEstimator_lin.run

3. The Welcome To Lattice Radiant Power Estimator setup dialog box 
opens.

4. Click Next to open the Installation Folder dialog box.

5. The default destination folder is /home/lattice/lscc/powerestimator/
diamond/3.14. Click Browse to change the destination folder.

6. Click Next to open the Select Components dialog box.

7. Click Next to open the License Agreement dialog box.

8. Read the license agreement. If you agree, click I accept the license to 
continue the installation process.

9. Click Next to Ready to Install dialog box. Review the destination folder 
and components selected. If everything is correct, select Install to start 
the installation.

10. In the Installation Wizard Complete dialog box, read the note and click 
Finish.
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Installing and Configuring USB Cable 
and Parallel Cable
This section provides information on USB cable and parallel cable installation 
and configuration. These instructions are applicable for 64-bit Linux systems.

Parallel Programming Cable Configuration

Before using the Lattice parallel programming cable, the computer’s parallel 
port must be enabled and have the correct read/write permission. Contact the 
system administrator if the parallel port is not enabled or does not have the 
correct read/write permission. 

You can check the current permissions of the parallel port by navigating to the 
/dev directory and doing a lookup on the port, as follows

% cd /dev ls –l parport0 

There are two main ways to give read/write permission to the parallel port. 
The first is to give read/write permission to the parallel port to anyone that has 
access to that machine. The second is more secure, where only selected 
individuals will have read/write permission to the parallel port that has access 
to that machine. Below are the descriptions on how to setup parallel port zero 
to have read/write permission. 

Giving Parallel Port Zero Read/Write Permission to All Users

1. Log in as root. 

2. Change directory to the /dev directory as follows:

% cd /dev <return> 

3. Give read/write permission to parallel port zero (parport0) as follows:

% chmod 666 parport0 <return> 

Giving Parallel Port Zero Read/Write Permission to Selected Individuals

There are two files to change on the machine to give selected individuals 
read/write permission to parallel port zero. Both files are located in the /etc 
directory. The two files are “group” and “nsswitch.conf”.

1. Log in as root.

2. Change directory to the /dev directory as follows:

% cd /dev <return>

3. Give read/write permission to parallel port zero (parport0) to owner and 
group as follows:

% chmod 666 parport0 <return>

4. Change directory to the /etc directory as follows:

% cd /etc <return>

5. Using your favorite text editor, edit the file “group” as follows:
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Add the login name for all the users you want to give read/write 
permission for parallel port zero by adding the login names to the 
“lp:x:7:” line. This line may vary from system to system. Two examples 
are shown below.

Example 1: Change:

lp:x:7: 

to:

lp:x:7:user_name1,user_name2,etc

Example 2: Change:

lp:x:7:daemon,lp 

to:

lp:x:7:daemon,lp,user_name1,user_name2,etc

where user_name1, etc., are the login names for all the users you 
want to give read/write permission for parallel port zero. Save the changes 
and close the “group” file.

6. Using your favorite text editor, edit the file “nsswitch.conf” as follows:

Look at the group line. Ensure “files” is there.

For example: 

group: files nis

7. Reboot for the changes to take effect.

Lattice USB Download Cable Configuration
Programmer software can directly access USB devices using libusb, which 
accesses the USB file system. To verify that you have the USB library 
installed, do the following:

1. Plug in the USB cable.

2. On the command line, type:

% lsusb
Lattice USB2A
You should see an entry similar to the following:
> Bus 001 Device 004: ID 1134:8001
HW-USBN-2B (FTDI)
You should see an entry similar to the following:
> Bus 001 Device 003: ID 0403:6010 Future Technology Devices 
International, Ltd FT2232C/D/H Dual UART/FIFO IC

3. If you receive an error when you type lsusb, you probably do not have 
libusb installed. To install the libusb, go to:

http://libusb.sourceforge.net/

The recommended version to install is libusb-0.1.4-3.el7.x86_64.rpm

http://libusb.sourceforge.net/ 
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4. Unplug the USB cable.

Driver Setup for Lattice USB2A and HW-USBN-2B 
(FTDI) USB Download Cable on Red Hat Linux 
Enterprise 7/8 

Automated UDEV Method Configuration

1. Type the following command to execute the script:

% sudo <install_path>/data/vmdata/udevsetup_rh7_8

2. Find your username, which is provided in /etc/group. Log out if required.

For example: 

username:x:1000:username

The script should terminate with a “Setup successful” output.

3. Replace the "username" with your username in /etc/udev/rules.d/10-
local.rules.

Manual UDEV Method Configuration:

1. Find your username, which is provided in /etc/group file. Log out if 
required. For example :

username:x:1000:username

2. Create a working file called 10-local.rules.

Note
The USB cable must be disconnected from the PC when performing the installations. 
You must have root access and be able to log in as a super user.

Note
User needs to download and install libusb-0.1.4-3.el7.x86_64.rpm first in Red Hat 7.

Note
You must reboot after creating the plugdev group in /etc/group. If plugdev already 
exists in /etc/group, you can verify this by typing “id” on the Linux command line.
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3. Add the following information to the 10-local.rules file:

4. Copy the file into the /etc/udev/rules.d/10-local.rules directory. If a file by 
this name already exists, simply append the working file to it. For 
example:

% sudo cp 10-local.rules /etc/udev/rules.d/ .
Or, if the file already exists:
% sudo cat 10-local.rules >>/etc/udev/rules.d/10-local.rules

5. Give permission to 10-local.rules as follows :

% sudo chmod 755 10-local.rules

6. Now reload the udev rules by

% sudo udevadm control –reload-rules

7. Plug in the usb cable.

Giving Lattice USB2A Drivers Read/Write 
Permission to Selected Individuals

USB Drivers Read/Write Permission Configuration

1. Plug in the USB cable.

2. In the command line, type:

% lsusb

 You should see an entry similar to the following:

> Bus 001 Device 004: ID 1134:8001

3. This mean the USB2A is in Bus 001 and device 004. Go to the directory.

% cd /dev/bus/usb/001

4. Grant execute permissions to the device. On the command line, type:

% sudo chmod 777 004

#Lattice
SUBSYSTEM=="usb",ACTION=="add",ATTRS{idVendor}=="1134",ATTRS{idProduct}=="8001",MODE==
"0660",GROUP=="username",SYMLINK+="lattice-%n"
#FTDI
SUBSYSTEM=="usb",ACTION=="add",ATTRS{idVendor}=="0403",ATTRS{idProduct}=="6010",MODE==
"0666",GROUP=="username",SYMLINK+="ftdi-%n"
SUBSYSTEM=="usb",ATTRS{idVendor}=="0403",ATTRS{idProduct}=="6010",RUN+="/bin/sh -c 
'basename %p > /sys/bus/usb/drivers/ftdi_sio/unbind'"

Note
 Each SUBSYSTEM entry must be a single line, or split using the “\” line 

continuation character.

 Replace the username with your username in above rules.
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Giving HW-USBN-2B (FTDI) USB Drivers Read/Write 
Permission to Selected Individuals

USB Drivers Read/Write Permission Configuration

1. Plug in the USB cable.

2. In the command line, type:

% lsusb

 You should see an entry similar to the following:

> Bus 001 Device 003: ID 0403:6010 Future Technology 
Devices International, Ltd FT2232C/D/H Dual UART/FIFO IC

3. The FTDI chip is in Bus 001 and Device 003. Go to the directory.

% cd /dev/bus/usb/001

4. Grant execute permissions to the device. On the command line, type:

% sudo chmod 777 003

5. Unload the ftdi_sio driver if it is attached to your device.

% sudo /sbin/rmmod usbserial

6. Unload the USB-serial driver if it is attached to your device.

% sudo /sbin/rmmod usbserial

Note

Licensing Lattice Diamond Software
The Lattice Diamond development tool and stand-alone Power Estimator are 
licensed software. In order for you to launch the tools you have to configure a 
FLEXlm license. The license can be either node-locked to the local machine, 
or acquired from a license server accessible from a LAN connection. The 
default location of the license file is <install_path>/license/
license.dat. If this location is changed, you must set the 
LATTICE_LICENSE_FILE environment variable to include the new path 
name.11.19.4.1.

The following environment user variables can be configured.

 LATTICE_LICENSE_FILE – A variable for lattice license file setting.

 SALT_LICENSE_SERVER – A variable required for launching 
QuestaSim’s latticeqsim feature.

 If you get the error, "rmmod: ERROR: Module usbserial is 
builtin." when running the command: "sudo /sbin/rmmod 
usbserial" on RedHat OS, please ignore it and proceed.
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License Management Versions
Table 3 lists the version numbers of the FLEXlm lmutil utility, the FLEXlm 
lmgrd utility, and the Lattice daemon used for license management for 64-bit 
systems.

Obtaining a License
To register and license your Diamond software:

1. Obtain the host ID of your license server with the following command:

% <install_path>/diamond/3.14/ispfpga/bin/lin64/lmutil 
lmhostid

2. Go to the Licensing section of the Lattice Semiconductor Web site 
(www.latticesemi.com/license) and follow the on-screen instructions.

Lattice Semiconductor will send your Diamond license file (license.dat) to 
you by e-mail within one working day. After you receive the license file 

Note
 Diamond software permits the creation of configuration bitstreams for all of Lattice 

Semiconductor's FPGAs. However, a license is required for some devices. 

 To use the included Questa Lattice OEM simulator, you need a license with the 
latticeqsim license feature. The licenses generated for use with the Modelsim 
Lattice OEM simulator have the latticemsim license feature and must be updated 
to the new feature to use Questa Lattice OEM. To start qsim, you need to set either 
the LM_LICENSE_FILE or SALT_LICENSE_SERVER.

 In order to change the LATTICE_LICENSE_FILE variable, you may need to edit 
the .cshrc or .bashrc configuration file located in your home directory.

Table 3: License Management Utility Versions
Filename Version Description

lmutil 11.19.4.1 FLEXlm license server utility

lmgrd 11.19.4.1 FLEXlm end-user utility

lattice 11.19.4.1 The Lattice Semiconductor licensing daemon

Note
Lattice Semiconductor supports licensing for a single server or three redundant 
servers. If you are using three redundant servers, enter all three server host IDs 
on the License File/Registration Form.

http://www.latticesemi.com/license
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from Lattice Semiconductor, copy the license.dat file to the Diamond 
license directory as follows:

% <install_path>/diamond/3.14/license/license.dat

Editing the License File
You must edit a floating license file to specify the server name and the path to 
the Lattice daemon.

The following example shows part of a floating license file:

SERVER nodename 1234abcd 1710
DAEMON lattice daemon_path
FEATURE LSC_RADIANT lattice 2025.06 12-jun-2025 1 4AB180876D89
\
VENDOR_STRING=LSC_RADIANT
FEATURE LSC_SYNPLIFYPRO1 lattice 2025.06 12-jun-2025 1
D86E40930FFB \
VENDOR_STRING="ispLEVER System with
Synplicity Pro 1"
FEATURE LSC_CTL_PROPBLD lattice 2025.06 12-jun-2025 1
8AE4CA6C0D82 \
VENDOR_STRING=LSC_CTL_PROPBLD
FEATURE LSC_CTL_PROPSDK_PFR lattice 2025.06 12-jun-2025 1 \
45FBE5EEB71D
VENDOR_STRING=LSC_CTL_PROPBLD

Edit the SERVER line by replacing the nodename with the host name and the 
port ID (1710). The port ID, 1710 in this example, must be assigned a TCP/IP 
port number that is not already in use on the server, so you might need to 
change it.

Edit the Lattice DAEMON line, replacing daemon_path with the path to 
Diamond software. For lmgrd V11, the path is:

% <install_path>/diamond/3.14/ispfpga/bin/lin64/lattice

Edit the QuestaSim DAEMON line, replacing daemon_path with the path to 
QuestaSim Lattice Edition. For QuestaSim, the path is:

% <install_path>/diamond/3.14/questasim/license_server/saltd

When editing these lines, type them exactly as you received them. All entries 
are case-sensitive. 

Starting the License Manager

Note
The encryption codes are in hexadecimal format (digits 0-9, and lower-case letters a-f 
or upper-case letters A-F). 

$HOME/.flexlmrc can be used to set LATTICE_LICENSE_FILE variable, and you 
should do the cleanup if it’s necessary.
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Type the following command on one line to start the license manager 
daemon:

% <install_path>/diamond/3.14/ispfpga/bin/lin64/lmgrd 
-l <install_path>/diamond/3.14/license/license.log 
-c <install_path>/diamond/3.14/license/license.dat

Redirecting output to a log file is helpful when you debug licensing problems. 
The -l switch tells the license manager to send its output to a log file 
(license.log), and -c tells it which license to serve. The log file contains 
information on the status of the server and the daemon and TCP port in use. It 
also shows which users have checked out the license and the checkout time.

Stopping the License Manager
If it is necessary to stop the FLEXlm license manager, follow this procedure:

1. Confirm that the daemon is running by typing the following command:

% ps -ef | grep lmgrd

2. If lmgrd.exe is running, type the following command on one line to stop the 
daemon:

For 64-bit systems:

% <install_path>/diamond/3.14/ispfpga/bin/lin64/lmutil 
lmdown -c <install_path>/diamond/3.14/license/license.dat

The following prompt appears:

Shutting down FLEXlm on nodes: <hostname>
Are you sure? [y/n]:

3. Type Y and press Enter to shut down the license daemon.

Installing and Running the License 
Manager on a Remote Server
You can install and run the License Manager from a location other than the 
default directory.

To install the License Manager to a different location, copy the files lattice, 
lmgrd, and lmutil from the following directory:

% <install_path>/diamond/3.14/ispfpga/bin/lin64/

to the desired location. For example:

% <remote_server_install_path>/my_machine/lattice_license/
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Starting the License Manager from a Remote Server
Type the following command on one line to start the license manager 
daemon:

% <remote_server_install_path>/lmgrd 
-l <install_path>/diamond/3.14/license/license.log 
-c <install_path>/diamond/3.14/license/license.dat

Stopping the License Manager on a Remote Server
If it is necessary to stop the FLEXlm license manager running on a remote 
server, follow this procedure:

1. Confirm that the daemon is running by typing the following command:

% ps -ef | grep lmgrd

2. If lmgrd.exe is running, type the following command on one line to stop the 
daemon:

% <remote_server_install_path>/lmutil lmdown -c 
<install_path>/diamond/3.14/license/license.dat

The following prompt appears:

Shutting down FLEXlm on nodes: <hostname>
Are you sure? [y/n]:

3. Type Y and press Enter to shut down the license daemon.

Setting Up a Floating License on Linux
The licensing steps just outlined can be performed on a centralized license 
server. Then each client points to the license file on that machine. 

To gain access to the licenses on the remote license server, you need to set 
the environment variable LM_LICENSE_FILE value to 
license_port_number@linux_host_name.

Note
Lattice Diamond software uses the following network communication ports (TCP/IP 
socket ports):

 Port 80 – This is the standard HTTP web access port.  Diamond uses this port in 
the following cases:

 When the Diamond software has updates from the Lattice web site:

 IP or reference designs are downloaded from the Lattice web site:

 When message ID's are sent.

 Port 7788 – This is the port used by the Diamond software to check the floating 
license between the software and license server.  This port is configurable by 
changing the license files.
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Troubleshooting a Floating License
The following procedures can be useful in troubleshooting common floating 
license issues.

Check the Network

Use the ping command to check network status. For example, type:

% ping <license_server>

If the license server is running, you can expect a return as follows:

64 bytes from <license_server> <IP_address>

To end, type CTRL+C.

Check License File with lmutil

Use the lmutil tool to troubleshoot the status of your license file. The lmutil tool 
is located in the following location:

<install_path>/diamond/3.14/ispfpga/bin/lin64

The lmstat command determines the features of your license file.

 The -a argument displays all information. 

 The -c argument uses the specified license files.

The following is an example of using the lmutil lmstat command to check the 
license file status:

% ./lmutil lmstat -a -c <license_port>@<license_server>

The license status is returned, including feature lines, number of licenses 
issued, and licenses in use.

Running the Lattice Diamond GUI
The Lattice Diamond software has a graphical user interface (GUI). When you 
run the diamond 3.14 executable file, the software automatically performs the 
environment setup.

To start the Lattice Diamond GUI:

1. Set up the license as follows:
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If your license file (license.dat) is not under <install_path>/3.14/license, 
you must set the LM_LICENSE_FILE variable to the location of your 
license file. For example:

For CSH users:

% setenv LM_LICENSE_FILE (/<license_directory>/license.dat 
$LM_LICENSE_FILE)

For BASH users:

% export LM_LICENSE_FILE=$LM_LICENSE_FILE:/
<license_directory>/license.dat

2. Run the diamond executable file in the command line as follows:

% <install_path>/diamond/3.14/bin/lin64/diamond &

With the diamond script, you can also run the following tools in stand-
alone mode. 

To invoke stand-alone Power Calculator, run:

% diamond -pwc

To invoke stand-alone Reveal Analyzer, run:

% diamond -rva

To invoke stand-alone IPexpress, run:

% diamond -ipx

To invoke stand-alone Epic, run:

% diamond -epic

Refer to the online Help for more information about the Diamond GUI.

Using the Examples Directory
In order to use the design examples directory, you must copy the files from the 
server to your local system and change the write permissions. Copy the files 
from the server examples directory (<install_path>/diamond/3.14/examples) 
to the equivalent path and directory on your local system.

Finding the Installation History
The Diamond software records a log of your installation history. You can find 
the history in the Diamond main window.

To view the installation history:

1. Open the Diamond GUI.

2. Choose Help > About Lattice Diamond.
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Running Lattice Diamond from the Command Line
There are two ways to run from the command line: through Diamond’s Tcl 
Console or by running executable files directly.

Running Stand-Alone Tcl Console
The Lattice Diamond development environment includes Tcl Console, which 
allows you to run scripts for automating common tasks. Tcl Console is also 
available outside of the user interface in order to run custom scripts. To launch 
the stand-alone Tcl Console, enter the following on a command line:

% <install_path>/diamond/3.14/bin/lin64/diamondc

These commands configure the environment allowing all of the underlying 
design tools to be run. Refer to the online Help for more information about the 
command line.

Running Using CSH or Bash 
Interpreters
Before running any other commands, you need to run the following command:

% cd <install_path>/diamond/3.14/bin/lin64 
% source setupenv

BASH users must run the following commands:

% export bindir=<install_path>/diamond/3.14/bin/lin64
% source $bindir/diamond_env

After that, you can run the executable files directly. For example, you can 
invoke the Diamond GUI by:

% pnmain &

Or, you can run Power Calculator by running:

% pwcmain &

Running Synplify Pro for Lattice
To run Synplify Pro for Lattice, do the following:

1. Open the Diamond GUI.

2. Open any project to enable the commands on the Tools menu.

3. Choose Tools > Synplify Pro for Lattice.



INSTALLING DIAMOND TOOLS : Running Stand-Alone Reveal Analyzer

Lattice Diamond 3.14 Installation Guide for Linux 27

Running Stand-Alone Reveal Analyzer
After the installation, you can invoke the stand-alone Reveal Analyzer in the 
command line:

% <install_path>/reveal/3.14/bin/lin64/revealrva &

Running Stand-Alone Programmer
After the installation, you can invoke the stand-alone Programmer in the 
command line:

% <install_path>/programmer/3.14/bin/lin64/programmer &

Running Stand-Alone Deployment Tool
After the installation, you can invoke the stand-alone Deployment Tool in the 
command line:

% <install_path>/programmer/3.14/bin/lin64/deployment &

Running Stand-Alone Debugger
After the installation, you can invoke the stand-alone Debugger in the 
command line:

Running Download Debugger on 64-bit systems:

% <install_path>/programmer/3.14/bin/lin64/debugger &

Running Stand-Alone Programming File Utility
After the installation, you can invoke the stand-alone Programming File Utility 
in the command line:

% <install_path>/programmer/3.14/bin/lin64/fileutility &

Running Stand-Alone Model 300 Programmer
After the installation, you can invoke the stand-alone Model 300 Programmer 
in the command line:

% <install_path>/programmer/3.14/bin/lin64/model300 &
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Running Stand-Alone Power Estimator
After the installation, you can invoke the stand-alone Power Estimator in the 
command line:

% set ROOT="<install_path>/powerestimator/3.14"
% set platform=lin64
% setenv LD_LIBRARY_PATH ${ROOT}/ispfpga/bin/
${platform}:${ROOT}/bin/${platform}
% set path=(${ROOT}/ispfpga/bin/${platform} ${ROOT}/bin/
${platform} $path)
% ${ROOT}/bin/${platform}/pwcwrap est &

Running Multiple Versions of Lattice Software
You can run multiple versions of ispLEVER and Lattice Diamond at the same 
time from either the command line or the graphical user interface. You can run 
current and previous versions.

Updating Lattice Diamond
After you have registered and licensed your installation, check the Lattice 
Semiconductor Web site for new software updates, device support, and 
enhancements. Make sure that you have the latest software by checking for 
updates regularly.

Running the UPDATE Tool
To run the UPDATE tool:

 Run the update executable file in the command line:

% update

The UPDATE window appears, as shown below.

Note
The stand-alone Power Estimator requires a license. See “Licensing Lattice Diamond 
Software” on page 19.
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Changing the Network Setting
To enable online checking for software updates, you must indicate how your 
computer accesses the Internet.

To change the Internet connection settings:

1. In the UPDATE window, choose Settings > Update Settings.

2. In the Update Settings dialog box, select the Network Setting tab.

3. In the Network Setting tab, do either of the following:

 If you must go through a proxy server before connecting to the 
Internet, select Use a Proxy Server (it is selected by default). The 
proxy server prevents outsiders from breaking into your organization’s 
private network. Ask your system administrator for the URL address 
and port assignment.

 If you use direct Internet access, clear the Use a Proxy Server option.

4. Click OK.
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Downloading and Installing Software 
Updates
When you use the automatic checking feature, the Diamond software notifies 
you whenever an update version becomes available.

You can also manually check for software updates.

To manually check for and download a Diamond update version:

1. In the UPDATE window, click Update.

The software goes online to check for updates, and lists the available 
Diamond update versions (if any) in the Available update versions box.

2. Select the update version that you want to download, and click 
Download.

The software starts downloading the installer of the update version to your 
computer. You may install it later.

To install a downloaded Diamond update version:

1. Close all Diamond tools.

2. Uncompress the downloaded installer.

3. Go to the location where you put the uncompressed installer.

4. From the command line, execute the RPM installation file.

Note
You can also use the Help > Check for Updates command in the Diamond window to 
check for and download software update.

Note
You need the root privilege to install an RPM package.
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Chapter 2

Installing LatticeMico 
Development Tools

This document explains how to install LatticeMico Development Tools on the 
Linux operating system.

System and Software Requirements
Your system must meet the following minimum system and software
requirements to run LatticeMico Development Tools on Linux.

System Requirements
 Intel Pentium or Pentium-compatible PC with USB port

 64-bit Red Hat Enterprise Linux version 7.9, 8.8 operating system

 2 GB memory recommended for FPGAs

 Approximately 436 megabytes of free disk space

 1024 x 768 graphics display 

Software Requirements
 Perl version 5.8.0 or later. The following Perl modules are required:

 XML::DOM

 XML::Parser

 XML::RegExp

 Getop::Std
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 Scalar::Util

 FindBin::Bin

These modules are normally found in the native version of Perl that 
comes with Red Hat Linux.

 PDF browser, such as Adobe Acrobat

 Mozilla or Netscape browser (optional)

Additional Notes for Linux
You may need the following information to run LatticeMico on Linux:

 If you want to configure your system to use an external browser instead of 
the Eclipse help browser, you can change this in the LatticeMico main 
window by choosing the Window > Preferences command.

 Eclipse requires shared libraries from the Mozilla (also known as 
Seamonkey) Web browser. The Eclipse software expects to find a set of 
IA32 shared libraries. It may be necessary for you to manually configure 
the MOZILLA_FIVE_HOME environment variable to point to a valid 
Mozilla browser library installation.

 If you cannot access the PDF files referenced in the LatticeMico online 
Help, you can configure LatticeMico to use an external browser by 
following these steps:

a. In the LatticeMico software, choose Window > Preferences.

b. Click on Help.

c. Select Use external browser.

d. Click on Web Browser.

e. Select Use external Web browser.

f. Select Firefox or Netscape.

g. Click OK.

Installing LatticeMico Within Diamond Software
LatticeMico Development Tools is included in the Diamond installation option 
now. You can select it when installing Lattice Diamond.

To take advantage of the full features and functionality of the LatticeMico 
Development Tools, Lattice Semiconductor recommends that you install the 
3.14 version of Diamond and the LatticeMico Development Tools.

Users designing with Platform Manager 2 devices must install LatticeMico 
System with Diamond in order to make the Diamond Platform Designer 
software functional.
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This section describes how to install the LatticeMico Development Tools 
within the Diamond software. 

To install LatticeMico Development Tools:

1. Select the LatticeMico in components page when install Lattice Diamond 
3.14.

2. After the installation is completed, verify that the /micosystem directory is 
created in the <install_path>/diamond/3.14 directory, for example, 
$HOME/lscc/diamond/3.14/micosystem.

3. You can then run LatticeMico System as follows:

% <install_path>/diamond/3.14/micosystem/LatticeMicoLauncher 
&

LatticeMico System Library Dependencies

LatticeMico System for Linux depends on a set of system libraries that are 
different from the Diamond base release package.

The following packages are the packages on which 
lLMS_1.2_for_Diamond3.14_lin.run are dependent. Indirect dependencies 
are listed with indented levels.

 glibc

 nss-softokn-freebl

 libjpeg

 glib2

 libselinux

 gamin

 libusb

 freetype

 fontconfig

 expat

 libX11

 libxcb

 libXau

 libICE

 libSM

Note
The LatticeMico software is integrated into the Diamond installation now.
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 libuuid

 libXt

 libXext

 libXrender

 libXi

 libXft

 libXtst

 alsa-lib

 atk

 nss

 nss-util

 nspr-devel

 nspr

 nss-softokn

 sqlite

 readline

 ncurses-libs

 gmp

 pango

 cairo

 libthai

 libpng

 pixman

 libXcomposite

 libXfixes

 libXdamage

 libXinerama

 libXrandr

 compat-expat1

 compat-libstdc++-33

 cups-libs

 avahi

 audit-libs

 avahi-libs

 dbus-libs

 libcap
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 libattr

 libdaemon

 libtiff

 gnutls

 keyutils-libs

 krb5-libs

 libgcrypt

 libgpg-error

 libtasn1

 gtk2

 jasper-libs

 perl-XML-DOM

 perl-XML-RegExp

Running LatticeMico System

After LatticeMico System is installed, enter the following command to run the 
software:

% <install_path>/latticemicosystem/3.14/LatticeMicoLauncher &
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Revision History

The following table gives the revision history for this document.

Date Version Description

10/21/2024 3.14 Updated to reflect changes in Diamond 3.14.

9/20/2023 3.13 Updated to reflect changes in Diamond 3.13.
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